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Big%picture%

3%

HTML%–%Hypertext%Markup%Language%
%Specifies%structure%and%meaning%

%
CSS%–%Cascading%Style%Sheets%
%Specifies%presenta@on%

%
JavaScript%
%Specifies%behavior%

%
PHP%–%PHP:%Hypertext%Preprocessor%
%One%of%many%backQend%op@ons%



A%history%of%hypertext%and%HTML%
1941:%Jorge%Luis%Borges%writes%The$Garden$of$Forking$Paths.$
%
1945:%Vanevar%Bush%describes%Memex%in%As$We$May$Think.$

%
1960:%Ted%Nelson%founds%Project%Xanadu%and%(1963?)%coins%
term%"hypertext".%
%
1967:%Brown%U's%Hypertext%Edi@ng%System;%used%for%Apollo.%
%
1969:%Charles%Goldfarb,%Ed%Mosher,%and%Ray%Lorie%at%IBM%
create%the%Generalized%Markup%Language.%%Leads%to%SGML.%
%
1987:%HyperCard,%by%Apple%
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History,%con@nued%
1990:%Tim%BernersQLee%and%Robert%Cailliau%at%CERN%write$
WorldWideWeb:$Proposal$for$a$HyperText$Project.%
%
1990:%BernersQLee%creates%first%browser:%WorldWebWeb,%later%
renamed%Nexus,%on%a%NeXT%computer.%
%
1991:%HTML$Tags%by%BernersQLee.%Influenced%by%SGML.%
%
1993:%Marc%Andreessen%and%Eric%Bina%at%NCSA%create%Mosaic.%%
First%developed%with%X11%then%released%for%Windows%and%Mac.%%
First%browser%to%show%images%inQline.%
%
1994:%Mosaic%Communica@ons%Corpora@on%founded%by%Jim%
Clark%and%Marc%Andreessen.%%Later%renamed%Netscape.%
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History,%con@nued%
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1994:%World%Wide%Web%Consor@um%founded.%
%
1995:%HTML%2.0%published%by%Internet%
Engineering%Task%Force%%(RFC%1866)%
%
1995ish:%Browser%wars%begin—Internet%Explorer%
vs.%Netscape%Navigator%(others,%too)%
%
January%1997:%HTML%3.2%published%as%W3C$
RecommendaEon.%%Incorporates%various%
propriety%extensions,%including%visual%markup.%
%



History,%con@nued%
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December%1997:%HTML%4.0%published%by%W3C.%%
Deprecates%visual%markup%in%favor%of%style%sheets.%
%
1998:%XML%1.0%Recommenda@on%by%W3C%
%
1999:%HTML%4.01%published%
%
2000:%XHTML%1.0%published%
%
2004:%Web%Hypertext%Applica@on%Technology%
Working%Group%(WHATWG)%begins%work%on%HTML5%
%
2008:%First%W3C%Working$DraG%of%HTML5%
%
%



HTML5%
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In%prac@ce,%"HTML5"%has%two%meanings:%
%The%fikh%major%version%of%this%markup%language%
%An%umbrella%for%many%web%technologies%

%
Current%W3C%status%for%the%markup%language%is%
"Candidate%Recommenda@on".%
%
Current%goal%for%reaching%"W3C%
Recommenda@on",%i.e.,%a%standard,%is%2014.%
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hlp://en.wikipedia.org/wiki/File:HTML5QAPIsQandQ
relatedQtechnologiesQbyQSergeyQMavrody.png%



"HTML"%for%us%
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We'll%consider%"HTML"%to%mean%the%markup%
language%specified%by%the%HTML5%Candidate%
Recommenda@on,%www.w3.org/TR/html5/%
%
It's%largely%HTML%4.01%plus%a%number%of%new%
elements%for%semanEc$markup%and%media%
support.%



Resources%for%HTML%%
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Head$First$HTML$&$CSS,%2nd%edi@on%by%Elisabeth%
Robson%and%Eric%Freeman.%%On%Safari.%
%
Mozilla%Developer%Network:%
%developer.mozilla.org%

%
W3C:%%%
%www.w3.org/TR/html5/%

%
Web%Hypertext%Applica@on%Technology%Working%
Group:%
%whatwg.org%



HTML%Basics%
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HTML%specifies%structure%

14%

Here%is%some%text%markedQup%with%HTML:%
%
<h1>Introduc@on</h1>%
<p>%
A%paragraph...%
</p>%
<ul>%
%%<li>First%item</li>%
%%<li>Second%item</li>%
</ul>%
<p>%
Second%paragraph...</p>%



What's%structure%good%for?%
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We%can%format%text%and%apply%styles%based%on%
types%and%structure.%
%FirstQlevel%headings%
%An%image%in%a%footer%
%Paragraphs%in%a%par@cular%class%of%lists%of%lists%

%
Programs%analyzing%pages%can%derive%meaning.%%
%An%ar@cle%
%Headers,%rows,%and%columns%in%table%
%Ordered%vs.%unordered%lists%

%
%



Element%anatomy%%
This%is%a%@tle%element:%
%<@tle>My%page</@tle>%

%
•  "@tle"%is%the%tag$name$
•  <@tle>%is%the%opening$tag$
•  </@tle>%is%the%closing$tag$
•  The%element's%content%is%"My%page"%

Some@mes%we'll%write%"<a>"%as%a%shorthand%for%
"the%'a'%element".%
%%

%
% 16%



Omipng%closing%tags %%
Closing%tags%can%be%omiled%in%a%few%common%cases.%
%
%<h1>Introduc@on</h1>%%
%<p>%
%A%paragraph...%
%<ul>%

%% % %<li>First%item%
%% % %<li>Second%item%
%</ul>%
%<p>%
%Second%paragraph...%

%
hlp://www.w3.org/TR/html5/syntax.html#op@onalQtags%

17%



Alributes%
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AKributes%for%an%element%can%be%specified%in%the%opening%
tag:%
%

%<p%id=intro%class=simple>%
%
id,%class,%@tle,%and%others%are%global$aKributes—they%can%
be%specified%for%any%element.%
%
Some%alributes%are%elementQspecific.%

%<img%src='pic1.png'%@tle="Fluffy's%Birthday">%
%
Quotes%can%be%'%or%". %%%They%are%op@onal,%with%rules.%
%
hlp://www.w3.org/TR/htmlQmarkup/syntax.html#syntaxQalributes%
hlp://www.w3.org/TR/html5/dom.html#globalQalributes%



Void%elements %%
Void$elements%never%have%content.%
%
Four%examples:%
%
%<br>%

%
%<hr>%

%
%<img%src="pic1.png">%

%
%<input%type="bulon"%value="Test">%

%
Void%elements%do%not%have%closing%tags.%
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Nes@ng%and%tree%structure%(corrected!)%%
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<body>%
<p>%
Text...%
<ul>%
<li>aa%
<li>bb%
<p>%
cc<br>dd%
</ul>%
</body>%

p% ul%

"Text..."%

p%

li%

br%

li%

"aa"% "bb"%

"dd"%"cc"%Note%the%combina@on%of%
elements%and%text$nodes.%

body%



Nes@ng%and%tree%structure%
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Tree%structure%cannot%be%forced.%
%
An%element's%content$model%specifies%what%the%
element%can%have%as%children.%
%
Based%on%the%previous%diagram,%what%can%we%say%
about%the%content%model%for%the%p,%ul,%and%li%
elements?$
%
Documenta@on%on%the%content%model%for%ul:%
hlp://www.w3.org/TR/html5/groupingQcontent.html#theQulQelement%
%



Lexical%details %%
Tag%names%and%alributes%are%caseQinsensi@ve.%
%
Comments%are%<!-- ... -->%and%do%not%
nest.%
%
Text%nodes%and%alribute%values%must%be%
Unicode%characters%>=%U+0020%(space)%except%
for%tab,%newline,%formfeed,%and%carriageQreturn.%
%
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Character%references%
Character$references%can%be%used%to%escape%
characters.%%There%are%three%forms:%
%
%&name;%% % % % %&copy;%&alpha;%&phone;%

%
%&#decimalMdigits; %&#65;%&#9742;%

%
%&#xHexMdigits; % %&#x41;%&#x260e;%

%
%
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hlp://www.w3.org/TR/html5/syntax.html#namedQcharacterQreferences%



Character%references%
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The%characters%&%and%<%can%appear%in%some%places%
but%not%others.%
%
%<p%@tle="<"> % % %OK!%
%c<d % % % % % %Trouble...%
%a&b % % % % % %Trouble!%

%
Solu@on:%Use%&amp;%and%&lt;%
%c&lt;d%%%a&amp;b%

%
What's%this?%
%@tle="&quot;&apos;1&amp;2&apos;&quot;"%



HTML%rendering %%
Browsers%produce%a%rendering%of%HTML.%
%
<h1>Introduc@on</h1>%
<p>%
A%paragraph...%
<ul>%
%%<li>First%item%
%%<li>Second%item%
</ul>%
<p>%
Second%paragraph...%
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Layout%engines%
A%browser's%layout$engine%is%the%component%that%
displays%HTML%content,%taking%all%markup%and%
styling%into%account.%
%
Browsers%have%various%engines:%
%
%Firefox%–%Gecko%
%IE%–%Trident%
%Konqueror%–%KHTML%(from%KDE)%
%Safari%–%WebKit%(based%on%KHTML)%
%Chrome%and%Opera%–%Blink,%fork%of%WebKit%

%
Usage%share%of%web%browsers%%
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Demo:%Chrome%Developer%view%
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Chrome:%View>Developer>Developer%Tools%
%Learn%the%keyboard%shortcut,%which%toggles%it%

%
Explore%element%structure—expand/collapse%with%mouse%
or%arrow%keys%
%
RightQclick,%Inspect%Element%is%another%way%to%bring%up%
the%Developer%Tools%view%
%
Breadcrumbs%at%bolom%show%path%to%element.%
%
We'll%see%later%that%the%blue/orange/green%areas%are%the%
content/margin/padding%in%the%box%model.%
%
hox1.html%
%
%



Quick%access%to%docs%

CSC%337,%Fall%2013,%HTML%and%CSS,%Slide%28%

To%go%directly%to%the%MDN%doc%for%the%"img"%tag,%
type%CtrlQL,%then%"mdnh%img"%%



Boilerplate%
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Boilerplate%
Browsers%render%our%examples%thus%far%but%
common%prac@ce%is%to%include%more%structure:%
%
%<!doctype%html>%
%<html>%
% %<head>...</head>%
% %<body>...</body>%
%</html>%

%
%
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<!doctype%...>%
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"<!doctype%...>"%indicates%which%set%of%specifica@ons%
the%browser%is%to%use%for%this%document.%
%
HTML%4.01%Transi@onal:%
%<!doctype%html%public%"Q//w3c//DTD%html%4.01%
% %transi@onal//EN">%%%(minimal%caps)%

%
HTML5:%
%<!doctype%html>%

%
Space%characters%and%comments%can%precede%
<!doctype%...>%



<head>%

32%

The%<head>%element%contains%metadata%
elements.%%
%
Most%common%are%<@tle>,%<style>,%and%<script>%
%
<@tle>%is%the%only%required%element%in%<head>%
%
%
%
%
%
hlp://www.w3.org/TR/html5/dom.html#metadataQcontent%



<meta>%
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The%meta%element%is%a%catchQall%for%metadata%that%
doesn't%have%its%own%element.%
%
A%common%use%is%to%specify%the%character$encoding:%
%
%<meta%charset="uyQ8">%

%
With%the%charset%alribute,%meta%can%only%appear%in%
the%head%element.%
%
hlp://www.joelonsokware.com/ar@cles/Unicode.html%



<body>%
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"The%<body>%element%represents%the%content%of%
the%document."%(W3C)%
%
One%way%to%think%about%it:%The%<body>%content%
is%what%you%see.%
%
Only%one%body%element%is%permiled.%
%%



All%together%
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<!doctype%html>%
<html>%
%%%%<head>%
%%%%%%%%<@tle>Gree@ngs</@tle>%
%%%%%%%%<meta%charset="uyQ8">%
%%%%</head>%
%%%%<body>%
%%%%Hello,%world!%
%%%%</body>%
</html>%
%%



Error%Handling%and%
Valida@on%
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HandsQon:%Error%handling%
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"Authors%must%not%use%HTML%elements%
anywhere%except%where%they%are%explicitly%
allowed,%as%defined%for%each%element,%or%as%
explicitly%required%by%other%specifica@ons."%
%QQW3C%

%
Let's%examine%some%errors...%
%
%



Error%handling%
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What%other%sokware%is%equally%permissive?%
%
Why%are%browsers%so%permissive%in%what%they%
accept?%
%
What%risks%are%posed%by%permissiveness?%
%
Speculate:%Are%browsers%equally%flexible%with%
CSS?%%JavaScript?%
%



HandsQon:%Markup%valida@on%
validator.w3.org%provides%valida@on%of%markup%
%
Let's%try%it!%
%
What's%the%minimal%valid%HTML5%document?%
%
%
%
%
hlp://www.w3.org/TR/html5/syntax.html#op@onalQtags%
%
%
%
%
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More%elements%
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strong,%em,%mark%
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<strong>%"gives%text%strong%importance"%
%
<em>%"marks%text%that%has%stress%emphasis"%
%
<mark>%represents%"a%run%of%text%marked%for%
reference%purpose,%due%to%its%relevance%in%a%
par@cular%context"%
%
%



strong,%em,%mark%
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I%<strong>strongly</strong>%
<em>emphasize</em>%that%
we%should%
<mark>mark</mark>%this!%
%
<strong><em><mark>%
I%strongly%emphasize%that%
we%should%mark%this!%
</mark></em></strong>%
%



Nes@ng%
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Improperly%nested%tags%won't%validate,%but%
typically%work.%
%
%This%is%<strong><em>strong%and%
%emphasized</strong></em>%text.%

%
%
%
%
%



q%for%quota@ons%
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The%q%element%is%used%for%short%quota@ons.%%The%
content%is%displayed%with%quota@on%marks.%
%
%<q>Life%is%hard.%%It's%harder%if%you're%stupid.%
%</q><br>&mdash;John%Wayne%

%
%
%
%
The%cite%alribute%can%be%used%to%cite%the%source.%
%
%
%



blockquote%
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Use%blockquote%for%longer%quota@ons.%%%
%
%Theodore%Roosevelt%said,%
%<blockquote>%
%Far%beler%is%it%to%dare%mighty%things,%to%win%%
%glorious%%triumphs,%even%though%checkered%by%...%
%</blockquote>%



Sidebar:%Structure%vs.%appearance%
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Elements%like%h1,%p,%ul,%and%li%are%clear%examples%
of%markup%that%describe%structure/meaning.%
%
Are%q%and%blockquote%describing%structure/
meaning%or%appearance?%%How%about%em%and%
strong?%
%
Would%elements%that%specify%bold,%italics,%and%
underlining%be%describing%structure%or%
appearance?%



b,%i,%and%u%elements%
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"The%b%element%represents%a%span%of%text%to%which%alen@on%is%
being%drawn%for%u@litarian%purposes%without%conveying%any%
extra%importance%and%with%no%implica@on%of%an%alternate%
voice%or%mood,%such%as%key%words%in%a%document%abstract,%
product%names%in%a%review,%ac@onable%words%in%interac@ve%
textQdriven%sokware,%or%an%ar@cle%lede."%
%
"The%i%element%represents%a%span%of%text%in%an%alternate%voice%
or%mood,%or%otherwise%offset%from%the%normal%prose%in%a%
manner%indica@ng%a%different%quality%of%text,%such%as%a%
taxonomic%designa@on,%a%technical%term,%an%idioma@c%phrase%
from%another%language,%translitera@on,%a%thought,%or%a%ship%
name%in%Western%texts."%
%
"The%u%element%represents%a%span%of%text%with%an%
unar@culated,%though%explicitly%rendered,%nonQtextual%
annota@on..."%



Content%Categories%
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Content%categories%
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Elements%are%in%zero%or%more%content$categories.%
%
%

(source:%MDN)%

Animated%diagram:%
hlp://www.w3.org/TR/html5/dom.html#kindsQofQcontent%



Content%categories%
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An%element's%specifica@on%includes%categories:%
%
%% 4.6.20%The%mark%element%

%Categories:%
% %Flow%content.%
% %Phrasing%content.%
% %Palpable%content.%
%Content%model:%
% %Phrasing%content.%

4.5.1%The%p%element%
%Categories:%
% %Flow%content.%
% %Palpable%content.%
%Content%model:%
% %Phrasing%content.%

Can%a%<p>%contain%a%<mark>?%
Can%a%<mark>%contain%a%<p>?%
Can%a%<p>%contain%a%<p>?%



Flow%content%
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"Most%elements%that%are%used%in%the%body%of%
documents%and%applica@ons%are%categorized%as%
flow$content."%(W3C)%
%
Examples:%
%ar@cle,%audio,%br,%code,%em,%embed,%form,%hN,%%
%header,%iframe,%img,%input,%math,%ol,%p,%%
%sec@on,%svg,%video%

%
Also,%text%is%considered%to%be%flow%content.%



Phrasing%content%
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"Phrasing%content%is%the%text%of%the%document,%
as%well%as%elements%that%mark%up%that%text%at%the%
intraQparagraph%level.%Runs%of%phrasing%content%
form%paragraphs."QQW3C%
%
What%elements%have%we%seen%that%are%phrasing%
content?%
%
%
hlp://www.w3.org/TR/html5/dom.html#phrasingQcontent%



Embedded%content%
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"Embedded%content%is%content%that%imports%
another%resource%into%the%document,%or%content%
from%another%vocabulary%that%is%inserted%into%
the%document."%(W3C)%
%
Examples:%
%audio,%embed,%iframe,%img,%math,%svg,%video%

%
math%and%svg%are%examples%are%examples%of%
content%from%another%vocabulary.%



Element%display%
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Element%display%
Two%common%types%of%element%display%behavior%
are%block%and%inline.%
%
Block%display%uses%all%available%width%and%causes%
line%breaks.%%<p>%uses%block%display.%
%
Inline%display%uses%only%as%much%width%as%
needed%and%does%not%cause%line%breaks.%%All%
(most?)%elements%that%are%phrasing%content%use%
inline%display,%including%img.%
%
%
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HandsQon%with%element%display%
Adjust%width%and%observe%how%layout%adjusts.%%
What's%the%algorithm?%
%
Experiment%and%classify:%
%ul,%li,%h1,%strong%

%
We'll%use%some%CSS%rules%to%explore%and%
understand%behavior%but%we%won't%get%caught%
up%in%CSS%yet!%
%
blockinline.html%

56%



Odds%and%Ends%
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Details%on%hN%elements%%
There%are%six%levels,%h1%through%h6,%from%most%to%
least%important.%
%
Default%rendering%produces%a%range%of%sizes%but%
do%NOT%use%levels%for%sizes.%%(Use%styles%instead!)%
%
Sokware%agents%might%use%headings%to%construct%
a%table%of%contents%for%a%page.%%The%W3C%
validator%has%an%op@on%to%produce%an%outline.%
%
%
%
%
%
%
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Details%on%lists%
There%are%three%list%elements:%
%
%ol %Ordered%list%

%
%ul %Unordered%list%

%
%dl %Descrip@on%list%(look%it%up!)%

59%



Ordered%lists%
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The%ordered%list%(ol)%element%is%used%for%lists%where%
the%sequence%is%important.%
%%
%<ol>%
% %<li>Place%order%at%counter%
% %<li>Pay%for%order%
% %<li>Wait%for%order%
% %<li>Eat%it!%
%</ol>%

%
Only%li%elements%can%be%children%of%ol.%
Note%that%</li>%is%not%needed%
%



Unordered%lists%

61%

The%unordered%list%(ul)%element%is%used%for%lists%
where%the%sequence%is%not%important.%
%
%<ul>%
% %<li>Sunscreen%
% %<li>Sunglasses%
% %<li>Beach%chair%
% %<li>Book%
%</ul>%

%
Only%li%elements%can%be%children.%
%



Problem:%ordered%bullets%
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Should%we%use%a%ul%element%to%show%a%sequence%
of%steps%if%we%don't%want%the%steps%numbered?%



<pre>%

63%

The%<pre>%element%is%used%for%preformaled%
text.%%Whitespace%is%preserved,%and%the%text%is%
shown%in%a%fixedQwidth%font.%
 
<pre> 
   |\      _,,,---,,_ 
   /,`.-'`'    -.  ;-;;,_ 
  |,4-  ) )-,_..;\ (  `'-' 
 '---''(_/--'  `-'\_) 
    Felix Lee 

</pre> 
%
%



Hyperlinks%
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The%anchor%(a)%element%
The%"hyper"%in%HyperText%refers%to%the%ability%to%
jump%from%one%point%in%text%to%another.%
%
Hyperlinks%are%defined%with%anchor%elements:%
%
%%%%Here's%the%<a%href="fp.html">fine%print</a>.%
%
%

65%



<a>%
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At%hand:%
%%%%Here's%the%<a%href="fp.html">fine%print</a>.%
%
Clicking%the%link%causes%the%browser%to%open%the%
HTML%document%in%the%file%fp.html%that's%in%the%
same%directory%as%the%current%document.%
%
Rela@ve%paths%to%files%can%be%used:%
%<a%href="tests/step1.html">First%step</a>%
%<a%href="../docs/gloss.html">Glossary</a>%

%
%



<a>%

67%

By%default,%clicking%a%link%opens%the%new%
document%in%the%current%view.%
%
The%target%alribute%can%direct%that%a%new%view%
be%created:%
%%
%<a%href="fp.html"%target="_blank">%

%
The%default%target%is%"_self".%%There%are%other%
targets,%too.%
%



hrefs%with%fragments%

68%

An%href%can%reference%a%fragment—a%name%
preceded%by%a%hash%mark:%
%
%%%%...the%<a%href="#rubric">grading%rubric</a>%...%
%
The%hyperlink%will%jump%to%the%element%on%this%
page%with%a%matching%id%alribute:%
%
%<h2%id="rubric">%
%<p>%
%The%grading%rubric....%

%
%
%
%



Problem:%glossary%page%

69%

hagloss1.html%



URL:%Uniform%Resource%Locator%
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A%URL%specifies%where%something%can%be%found%and%how%it%
should%be%accessed.%
%
Here's%a%URL%for%the%glossary%page%from%the%previous%slide:%

%file:///w/337/s/hagloss1.html%
%

%Its%scheme%is%"file"%(some%call%it%the%protocol)%
%

%Its%path%is%/w/337/s/hagloss1.html%
%
The%URL%above%has%no%host,%but%this%is%equivalent:%

%file://localhost/w/337/s/hagloss1.html%
%
On%Windows%I%might%have%used%this,%assuming%a%subst%for%w:%

%file:///w|/337/s/hagloss1.html%
%
%
%
%
%
%



An%anchor's%href%specifies%a%URL%
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The%anchor%element's%href%alribute%must%specify%a%URL,%but%in%
anchor1.html%we%used%this:%
%

href="fp.html"%
%

That's%considered%to%be%a%rela@ve%URL.%
%
The%absolute%URL%for%anchor1.html%is%

%file:///w/337/s/anchor1.html%
%
The%corresponding%base%URL%is%

%file:///w/337/s/%
%
Thus%href="fp.html"%is%equivalent%to%

%href="file:///w/337/s/fp.html%
%
Is%it%beler%to%use%absolute%URLs%or%rela@ve%URLs?%
%



The%hlp%URL%scheme%
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A%more%common%scheme%is%"hlp".%%Here%are%some%
absolute%URLs%with%the%hlp%scheme:%
%

%hlp://google.com%
%

%hlp://localhost:8080/x.html%
%

%hlp://support.microsok.com/?kbid=315265%
%
URLs%using%the%hlp%scheme%can%have%several%parts:%
%

$scheme%://%host$:port$/$path$?$queryMstring$#$fragment$
%
:port%and%/%path%...%are%op@onal.%
%
%



The%hlp%scheme,%con@nued%
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When%the%"file"%scheme%is%used,%the%browser%
opens%the%file%directly.%
%
When%the%"hlp"%scheme%is%used,%the%browser%
uses%the%Hypertext%Transfer%Protocol%(HTTP)%to%
fetch%the%data.%
%
The%"hlps"%scheme%is%very%similar%but%uses%
Hypertext%Transfer%Protocol%Secure%(HTTPS).%
%
We'll%talk%about%HTTP%and%HTTPS%later.%



The%hlp%scheme,%con@nued%
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Here's%a%URL%that%accesses%another%copy%of%
anchor1.html:%
%
%hlp://www.cs.arizona.edu/classes/cs337/fall13/
%slides/anchor1.html%

%
What's%the%base%URL%in%this%case?%
%
Here's%a%URL%with%a%fragment.%%What%does%it%
reference?%
%
%hlp://www.cs.arizona.edu/classes/cs337/fall13/%
%slides/hagloss1.html#p%



The%mailto%scheme%
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The%"mailto"%scheme%produces%a%link%that%when%
clicked%opens%the%user's%mailer%and%creates%a%
message.%
%

Or%<a%href="mailto:xyz@cs.arizona.edu">%
mail%me</a>%for%more%info!%

%
Due%to%spammers,%public%facing%"mailto"%URLs%
are%seldom%used.%
%

anchormail1.html%



Images%
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Images%
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The%img%element%displays%an%image.%
%
The%src%alribute%specifies%the%source%of%the%image,%
which%can%be%a%local%file%or%a%URL%(more%on%URLs%
soon)%
%
%<img%src="lavender.jpg">%

%
%<img%src="hlp://bit.ly/16LF9DG">%

%
Images%have%inline%display.%
%
img%is%a%void%element.%
%
%



Image%sizing%
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By%default,%an%image%is%shown%at%its%na@ve%size%in%
pixels.%
%
Use%width%and%height%alributes%to%display%at%other%
sizes.%
%
If%only%one%is%specified,%the%other%is%calculated%to%
preserve%the%aspect$raEo%(width:height)%
%
If%both%are%specified,%the%image%is%stretched.%
%
Example:%img1.html%
%
%



Image%sizing,%con@nued%
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Image%resizing%for%width/height%alributes%is%
done%in%the%browser.%
%
Shrinking%images%in%the%browser%wastes%network%
bandwidth.%
%
HFHC%recommends%always%specifying%width%and%
height,%to%save%recalcula@on%of%layout.%
%
With%PHP%we'll%use%ImageMagick%for%resizing%



img's%alt%alribute%

CSC%337,%Fall%2013,%HTML%and%CSS,%Slide%80%

The%%alt%alribute%"defines%the%alterna@ve%text%
describing%the%image.%Users%will%see%this%
displayed%if%the%image%URL%is%wrong,%the%image%is%
not%in%one%of%the%supported%formats,%or%un@l%the%
image%is%downloaded."%–%MDN%
%
There's%a%LOT%wrilen%about%alt%in%the%CR.%
%
Example:%imgalt.html%(try%with%Chrome,%Firefox,%
and%Opera)%



Image%formats%
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There%are%three%widely%supported%image%
formats:%
%
%JPEG% %Joint%Photographic%Experts%Group%

%
%GIF % %Graphics%Interchange%Format%

%
%PNG % %Portable%Network%Graphics%("ping")%



JPEG%
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Created%for%compressing%photographs%
%
Millions%of%colors%
%
No%transparency%
%
"Lossy"%compression;%ar@fact%on%drawn%lines%
%Compare%blockAQq20.jpg%and%blockA.png%

%
Can%trade%off%compression%against%image%quality%
%Examples%on%hlp://en.wikipedia.org/wiki/Jpeg%

%
%
%



GIF%
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Maximum%of%256%unique%colors%per%frame,%from%
palele%of%16%million.%
%
Can%contain%mul@ple%frames,%for%anima@on%
%
Lossless%compression%
%
One%transparent%color%per%frame—provides%
transparency%but%not%of%varying%degree%
%
"Choosy%developers%choose%GIF"%
%
Example:%imggif1.html%



PNG%
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Lossless%compression;%might%be%smaller%or%larger%than%
corresponding%GIF.%
%
No%anima@on%
%
Supports%variable%transparency%(see%imgxp1.html)%
%
PNGQ8%(256%colors),%PNGQ24%(16M%colors),%
PNGQ32%(16M%colors%+%8Qbit%transparency)%
%
Crea@on%mo@vated%by%IP%(intellectual%property)%issues%
with%GIF%compression%algorithm%
%
Examples:%blockA.png,%awvip.png,%and%others%



PNGQ8%or%PNGQ24?%
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Two%ways%I%know%to%find%out%which%you've%got:%
%
%%file%*.png%%%#%*NIX%file(1)%(do%"man%file"%for%documenta@on)%
blockA.png:%%%%%PNG%...,%3264%x%3219,%8Qbit/color%RGBA,%...%24%
googlelogo.png:%PNG%...,%550%x%190,%8Qbit%colormap,%...%8%
lavender.png:%%%PNG%...,%2592%x%1944,%8Qbit/color%RGB,%...%24%
%

Open%with%Photoshop%and%look%at%top%bar:%
%"x.png%(Index)"% %(PNGQ8)%
%"y.png%(RGB/8)"%(PNGQ24)%



GIF,%JPEG,%or%PNG?%
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Photograph?%
%JPEG!%

%
Animated?%
%GIF!%

%
Drawing?%
%GIF%or%PNG%

%
Transparency%needed?%
%GIF%or%PNG%

%
Good%stuff%on%image%formats:%HFHC%pp.%167Q169%
%
%
%
%
%
%

1.9M%lavender.gif%
2.6M%lavender.jpg%
6.5M%lavender.png%
(img3.html)%



Adding%transparency%with%GIMP%
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I%don't%know%much%about%GIMP,%but%having%said%that...%
File>Open...%
Layer>Transparency>Add%Alpha%Channel%
Select%"Fuzzy%Select%Tool"%(a.k.a%magic%wand)%
Click%on%an%area%you%want%make%transparent%
%Maybe:%undo,%adjust%threshold,%and%try%again%
% %(Windows>Dockable%Dialogs>Tool%Op@ons)%

Right%click>Edit>Clear%
%Gray%checkerboard%should%appear%

File>Export,%select%GIF%or%PNG%for%File%Type%
%
See%HFHC%p.204Q208%for%a%technique%involving%backgrounds.%
%

imgxp.html%
%
%
%
%



Simple%drawing%with%GIMP%
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Mul@Qcolor%filled%rectangle:%
%File%>%New...,%pick%dimensions%
%Pick%color%using%swatches%at%bolom%of%toolbox%
%Select%Bucket%Fill%tool%
%Click%in%rectangle%to%fill%it%
%Select%Rectangle%Select%Tool%
%Drag%with%mouse%to%sweep%out%a%rectangle%
% %Note%tool%op@ons%for%Fill%Type%and%Affected%Area%
%Make%marks%with%Pencil,%Brush,%or%Airbrush%

%
A%key%to%avoiding%madness:%If%there's%a%selec@on%ac@ve,%you%
can%only%draw%in%it!%%(Select>None%to%clear%it.)%
%



Viewing%GIF%frames%with%GIMP%
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Open%file%
Right%click>Filters>Anima@on>Playback%

Opens%a%window%(with%terminalQlike%icon)%named%
"Anima@on%Playback"%
Seems%like%no%way%to%go%backwards%or%view%all%
frames%at%once. %%

%
Photoshop:%just%open%it%and%look%for%"Anima@on%
(Frames)"%tab.%



Supported%Formats%
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The%HTML5%CR%does%not%require%that%any%specific%
image%format%be%supported.%
%
img's%src%must%reference%"a%nonQinterac@ve,%
op@onally%animated,%image%resource%that%is%
neither%paged%nor%scripted."%
%
Support%for%GIFs,%JPEGs,%and%PNG%is%common.%


